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...from any WHERE, any TIME at:  http://chapter.pmi.org/ppr/pprc-index.html                                            

Welcome to 2004!  I hope everyone had a safe and enjoyable 
holiday season.  It’s hard to believe the big Y2K crunch that 
many of us worked on was done more than four years ago. 

January is always a good time to assess where we are at and 
where we want to go.  It’s the month to set goals, establish 

resolutions, and apply any 
desired course correction 
to our lives.  This is also 
true of the PPRC. 

The first meeting of your 
new chapter officers will be 

the longest, and probably the most important, of all of the 
meetings we will hold this year.  High on the agenda will be 
the formulation of a strategic vision for the chapter.  Where are we?  Where do we 
want to be?  How do we get there?  As this process unfolds we will be sharing the re-
sults with our membership and inviting your comments. 

We are also in the throes of our first participation in PMI’s annual Project of the Year 
(POY) recognition program.  Our coverage by the local newspaper has been minimal, 
so for this inaugural year we strongly need your support in getting the word out.  We 
have emailed the relevant information to our members, and details can also be found 
via our website at: http://chapter.pmi.org/ppr/pprc-index.html.  If your company has a 
project they want to showcase this is an excellent opportunity to do so.  Help us find 
some success stories! 

I consider it a privilege to serve you as president for another year.  I wish the best for 
you and your loved ones in the year ahead. 

President’s Corner 

...Where are we?  Where do 
we want to be?  How do we 

get there?... 
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2004 PMI PROJECT OF THE YEAR AWARD 
All projects, regardless of size and industry, are encouraged to participate. 
 

Purpose:  To recognize and honor the accomplishments of the PMI Project of the Year (POY), 
and the project team involved, for superior performance and execution of exemplary project 
management. 
 

The PMI Project of the Year Award is aligned with the Institute’s Strategic Plan in the following 
areas: 

·  Image and Brand 

·  Knowledge 

Eligibility:  Projects from everywhere in the world are encouraged to participate, regardless of 
size, industry type or location.  PMI affiliation is not necessary.  Other professional associations 
are invited to encourage participation.  The project must be essentially 
complete at the time of nomination and accepted as complete by the 

�

Bill Landers, PMP 
PPRC President 

Find us ONLINE... 

(Continued on Page 7) 
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When managing projects in Microsoft 
Project, we provide a great deal of infor-
mation that could be extremely useful for 
all types of analysis and reporting. The 
challenge is getting the information back 
out of the tool. MS Project comes with a 
number of extremely useful default views 
that allow us to see many aspects of our 
project information. However, only a 
small subset of the available fields in 
Project, containing this data, show up in 
the default views. If the default views do 
not meet our needs, we can create cus-
tom views��

What Is A View? 

To extract any kind of meaningful infor-
mation from our projects it is important 
that we understand the meaning of 
Views in Microsoft Project. A View is  
simply a way of looking at our data and is 
defined by Microsoft Project as follows: 

View = Screen + Table + Filter + Group 

 

Create a New View – 4-Step Method 

Creating a new View is as simple as fol-
lowing a 4-step method. The four steps 
needed to create a new View are fairly 
straight forward, and are based on the 
definition of a View seen above. These 
steps are: 

1. Select or create a Table -a collection 
of fields. From the View menu select 
Table, More tables… 

2. Select or create a Filter – extracts 
data that meets certain criteria.  
From the Project menu, select Fil-
tered for, More filters… 

3. Select or create a Group – sorts and 
summarizes data.  From the Project 
menu, select Group by, More 
Groups… 

4. Create a new View using the desired 
Screen, Table, Filter, and Group 
From the View menu, select More 
views…  

The Screen 

The Screen is a very important part of 

any custom View, but is often misunder-
stood when creating new Views. The 
Screen controls how the project data is 
“laid out” on the screen. The Screens 
from which we may choose are found in 
the View Definition dialog box, as is 
shown in the following illustration: 

 

View Definition Dialog Box: 
Screen Types 

Notice in the preceding illustration that 
our Screen choices are the same as 
many of the common Views we are used 
to seeing in Microsoft Project. For in-
stance, our Screen choice will allow us to 
decide whether to include the Gantt Chart 
on the right of our new View (as with the 
Gantt Chart view), or whether the Task 
Sheet will be displayed without a Gantt 
Chart (as with the Task Sheet view). 

 

As a best practice, it is recommended to 
leave the default views, tables, filters, 
and groups in MS Project as they are. If 
there isn’t a default that meets your 
needs, you can copy an existing one, 
rename it and alter it to meet your needs 
or create a new one from scratch. Cus-
tom items exist only in the project where 
they are created. If you wish to use a cus-
tom item in other projects you can utilize 
the Organizer found on the Tools menu 
to share them with other specific projects 
or the Global.mpt to share them with all 
your projects.  �  

Creating Microsoft Project Views to Examine Project Information 

“ To extract any kind of 
meaningful 

information from our 
projects it is important 
that we understand the 
meaning of Views in 
Microsoft Project...”   

By Genea Mallow-Jensen 

Genea Mallow-Jensen, 
PMP, is Vice President of the 
local chapter of the Microsoft 
Project Users Group, and a Senior 
Consultant with Milestone Con-
sulting Group, Inc.  Genea  spe-
cializes in Microsoft Project in-
struction.  
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pleted in order to address the risk. 
Some risks require immediate action, 
while others can safely be left until later. 
We must be careful not to leave it too 
late before we act. 

 

Achievable – There is no point in de-
scribing risk responses which are not 
realistically achievable or feasible, ei-
ther technically or within the scope of 
our capability and responsibility. If your 
planned response is “Hope for a mira-
cle” or “Invent a radical new solution”, 
you may be disappointed!  

 

Assessed – All proposed risk re-
sponses must work! The “risk-
effectiveness” of a response is best de-
termined by making a “post-response 
risk assessment”. This assesses the 
level of residual risk assuming effective 
implementation of the response, includ-
ing secondary risks of course. The 
situation after implementing the risk re-
sponse must be better than before! 

 

Agreed – The consensus and commit-
ment of relevant stakeholders should be 
obtained before agreeing responses, 
especially if the proposed response 
might affect a part of the project in 
which they have an interest. 

 

Allocated & Accepted – Each risk re-
sponse should be owned by a single 
person (and accepted by them) to en-
sure a single point of responsibility and 
accountability for implementing the re-
sponse. Allocating risk responses re-
quires careful delegation, including pro-
vision of the necessary resources and 
support to allow effective action to be 
taken. 

 

Each proposed risk response should be 
assessed against these seven criteria 
before it is accepted. A “Grade A” re-
sponse will pass all these tests, and is 
more likely to achieve the desired effect 
than a response which has not been 
properly considered or evaluated.  �  

Grade A Risk Responses 

How can we tell if our risk 
responses are good enough? 
Here are seven “ Grade A”  
criteria by which you can 
test whether your planned 
risk responses are likely to 

work... 

It is easy to understand why some peo-
ple think that the risk response devel-
opment phase is the most important 
part of the risk process. This is where 
we get the chance to make a difference 
to the risk exposure of our project. If we 
design and implement good risk re-
sponses to address the risks we have 
identified and assessed, we will be able 
to minimise threats and maximise op-
portunities, and so optimise the likeli-
hood of achieving our objectives. But if 
our risk responses are ineffective (or 
not implemented), the level of risk ex-
posure remains unchanged – or may 
even get worse! 
 

But how can we tell if our risk re-
sponses are good enough? Can we 
assess their potential effectiveness be-
fore we decide to implement them? 
Here are seven “Grade A” criteria by 
which you can test whether your 
planned risk responses are likely to 
work. To be effective, all proposed risk 
responses should be : 

 

Appropriate – The correct level of re-
sponse must be determined, based on 
the significance of the risk. This ranges 
from a crisis response where the pro-
ject cannot proceed without the risk 
being addressed, through to a “do noth-
ing” response for minor risks. We 
should not spend large amounts of time 
or effort developing aggressive re-
sponses for minor risks, but we must 
also not spend too little time consider-
ing how to deal with key risks. 

 

Affordable – The cost-effectiveness of 
risk responses must be determined, so 
that the amount of time, effort and 
money spent on addressing the risk 
does not exceed the available budget 
or the degree of risk exposure. Each 
risk response should also have an 
agreed budget, added to the approved 
project cost plan. 

 

Actionable – An action window should 
be determined, defining the time within 
which risk responses need to be com-

By Dr David Hillson 
PMP FAPM 

To provide feedback on this  
article, or for more details on 
how to develop effective risk 
responses, contact the  
Risk Doctor (info@risk-
doctor.com), or visit the  
Risk Doctor website  
(www.risk-doctor.com). 



�The PPRC Communicator                                                                          Page 4 

�

If people would just leave me alone – I 
know I would get my job done faster, with 
a high level of quality and efficiently.  
How many times have you asked your-
self that question throughout your project 
management career?  More times than 
you care to count, right?  Well … as pro-
ject managers, we thrive (and struggle) 
due to the various stakeholders (a.k.a. – 
project team members) on our team.  Let 
me share a few scenarios with you to 
help you understand and appreciate the 
diverse set of skills that lie within your 
project teams and how you can leverage 
these skills to your advantage.  

 

Scenario 1 - We are two months into a 
seven-month project – I started a month 
“late” on the project due to other project 
commitments.  When I arrived my project 
team had already been selected and 
everybody was doing “something” but 
appeared to be going in different direc-
tions.  The person who held the project 
manager position prior to my arrival was 
not a project manager by profession – 
but they filled my role valiantly until I 
could arrive.  Let’s call this gracious per-
son, Lionel. 

 

Lionel continues to give the team direc-
tion even though I’m now onboard and 
should be providing direction and leader-
ship to the team members.  He fre-
quently sends the technicians down a 
path without even discussing the ideas 
and suggestions with me first.  He is 
causing a lot of confusion and frustration 
amongst the project team.  Many team 
members have come to me wanting to 
know who they are supposed to take 
guidance from because they are getting 
it from me and Lionel and the advice is 
frequently contradictory.  The team mem-
bers just want to get their job done right 
the first time and not go back and forth 
on decisions/directions.  Lionel is a very 
creative person with lots of ideas and 
thoughts – it’s driving me nuts! 

 

Scenario 2 -  Your lead architect is fre-
quently going to the customer with her 
conceptual ideas, without coming to see 
you first.  The customer LOVES the 

 

People Are SO Annoying 

� ���we all talk about 
how important diversity 
is to a team – but when 
conflict surfaces due to 
diversity, we shudder 
with frustration instead 
of embracing it with 
excitement! ”  �

By Denise DeCarlo, PMP  

ideas and wants to implement them 
NOW.  To make things worse you over-
hear this customer saying “Change con-
trol, what is change control”? 

 

 Scenario 3 -  You give someone a de-
tailed assignment and they nod like they 
understand the assignment but then they 
don’t finish it on time and/or with the level 
of quality you anticipated.   This person is 
an experienced team member and you’re 
surprised at their lack of performance. 

 

 Scenario 4 - It’s noon on Tuesday and 
you’re ready to leave for a quick bite to 
eat.  Your manager comes to your work 
area and asks for your help in putting 
together the report for the Weekly Lead-
ership Team meeting at 4pm.   You 
cringe.   This is the 3rd week in-a-row 
your manager has come to you at the 
“last minute” to put this report together 
and they ask for different information 
each week.  You reluctantly agree to help 
out, but make a point of saying you’d pre-
fer to perform this work in a 
planned/organized fashion instead of 
waiting until the last minute.  Your man-
ager looks at you with a surprised look!  
Now, you are surprised too!  Your man-
ager explains to you that they thought 
you’d WANT to be involved so you could 
get exposure to creating management 
level reports.   You cautiously explain that 
you would like to contribute, but for you to 
do it at the last minute is not effective for 
you.  Your manager is surprised because 
she is very creative under pressure and 
likes producing the report at the “final 
hour” – plus she’s able to include current 
information in the report.  You both agree 
to find a “time” each week to work on the 
report together so you can get the experi-
ence desired without the stress of having 
to do it at the last minute.  She will con-
tinue to make last minute adjustments to 
ensure it reflects what is happening NOW 
on the project.   

 

 Do these scenarios send chills up your 
spine?  Are there people are your project 
team that are well intentioned, but wreak-
ing havoc amongst your team?  Welcome 
to diversity!  Seriously, we all talk about  

Denise DeCarlo is a senior 
instructor for ESI and is President 
of Mindavation, a Colorado based 
company providing project man-
agement training & consulting, 
leadership workshops and team 
building programs worldwide. 
Denise can be reached at Minda-
vation via the web at 
www.mindavation.com or by call-
ing 866-888-MIND (6463). 

(Continued on next page.) 
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(from previous page.) 

how important diversity is to a team – but when conflict 
surfaces due to diversity, we shudder with frustration 
instead of embracing it with excitement!  There are peo-
ple who are going to have ideas and approaches com-
pletely contradictory from yours.  That doesn’t mean 
you are right and they are wrong.  It means we need to 
work together as a team to determine the right mix of 
creativity, project planning, socialization, and team deci-
sion making.  Sometimes we have to dig deep to begin 
to understand and appreciate ALL the skills that are 
brought to bear on a given project team.  This doesn’t 
mean you need to LIKE everyone on your team, but it 
does mean we need to respect and appreciate the skills 
(and styles) brought to bear. 

 

All the people.  All the diversity.  All the problems!  I 
have found over the years that a lack of communication 
and understanding leads to many problems.  The more 
we begin to understand our team members (including 
customers) the more effective we become as project 
managers and leaders.  I have found it effective to ob-
tain the following information about key stakeholders on 
my project team: 

1. General background – what is their history and ex-
pertise?  Seems like something obvious but we 
have a tendency to assume we know a person’s 
history based on what they are doing today.  Your 
assumptions may not be valid! 

2. Find out what they enjoy about your project – what 
are they hoping to get out of this project? 

3. Determine their level of expertise based on their 
various job responsibilities.  Are there components 
in their work assignments new to them?  Are they a 
seasoned veteran ready for a promotion?  This in-
formation is valuable to me as their project man-
ager because it helps me determine how much as-
sistance is appropriate for assignments given and 
the complexity of the assignments I can delegate. 

4. Assess their desire for being stretched.  Some peo-
ple LOVE to be challenged and stretched.  Others 
would just as soon do the same thing (or roughly) 
each week because they enjoy doing things with 
which they are familiar.  Find out their preferences. 

5. Determine what their tendencies are: 

a. Is the person creative and really good at 
brainstorming and generating ideas?  I call 
this person a “Questioner” 

b. Are they a planner?  If you provide them the 
approved idea or concept, are they great at 
flushing out the detail to get the job done?  
(i.e.: they can whip out a WBS in no time and 
love doing it!) 

c. Are they an action oriented person who would 
prefer assignments that are clearly defined 
and then they “go get the job done”? 

Is the person socially focused?  Are they good at 
working with several different departments to under-
stand and evaluate the best way to implement a so-
lution?  Do they enjoy working with others vs. on 
their own and are they effective at communicating 
with personnel at all levels of the organization? 

 

If there’s someone on your team that is especially 
creative – they will likely drive the planner person 
nuts (and vice versa)!  The creative person is busy 
thinking of all kinds of ways to solve a problem and 
the planner just wants a decision made to start de-
tailing out the job!  If you give an action oriented per-
son an open-ended task and tell them to figure out 
the best way to get it done – they likely will struggle 
and get frustrated because they prefer (and need) a 
lot of detailed information before they can proceed 
confidently with their assignment.  If you give that 
same assignment to a planner; they will be thrilled!  
The key to teaming and not getting so annoyed with 
the various behavior types on a given team is under-
standing their needs and desires. This includes: 

·  Acknowledging the different behavior types that 
exist – talk about this as a team. 

·  Understanding what each person’s tendencies 
are (Planner, Questioner, etc). 

·  Matching job responsibilities as best as possible 
with each person’s behavior tendency (Action, 
Social, Planner, Questioner). 

·  Realize your behavior tendencies change under 
stress (watch out!). 

·  Be honest with each other – but be professional!  
If someone is annoying you – tell them you are 
frustrated and why.  More than likely they had no 
idea they were frustrating you and a miscommu-
nication is contributing to the problem. 

 

Are people still annoying me? You bet!  But do I lev-
erage our differences?  I sure hope so!  Any time I 
get really frustrated with someone on my project 
team – I take a deep breath and say “ok – what les-
son can I learn here?”  How can I leverage this per-
son’s skills to my advantage instead of being frus-
trated by their different style or approach?  This is 
not something that always comes naturally to me, 
but I find when I do this, my effectiveness as a 
leader grows!  I challenge you to take the person on 
your team today that you find the most annoying and 
try to establish a better working relationship with 
them.  Go through the steps specified above and 
you too will begin to appreciate the diversity on your 
team!  �   
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How many peer reviews or testing events 
have your team accomplished during 
which no defects were found?  If the an-
swer is “a bunch,” your team may be 
afraid to highlight defects.  Why? Be-
cause they likely feel it would highlight 
flaws in their personal performance. 

 

Is a defect in development a bad thing?  
Quite often our team members’ percep-
tion is that the identification of a defect 
highlights an oversight, or a mistake 
(Heaven forbid!).   Well, yeah!!  It does 
mean that.  It also means the person 
who produced the product is human. 
 

Because defects in the production of our 
projects’ deliverables are inevitable, we 
have peer reviews, project audits and 
testing events to find the bugs our project 
team members create before they are 
introduced to the production environment 
– where they can really cause havoc. 
 
In fact, according to Capers Jones of 
Software Productivity Research, Inc., a 
bug created in the requirements phase of 
a project that is not discovered before it 
goes into production typically costs 800 
times more to fix, than it would have if it 
had been discovered in the phase in 
which it was created. 
 

Consequently, it’s in your project team’s 
best interest (and your client’s) to hon-
estly find, and fix the problems using the 
means you’ve established in your proc-
esses to find and fix them.  But, there’s 
also an advantage to honestly report all 
bugs found and fixed. 
 

That advantage manifests itself in a dis-
ciplined metrics collection system.  As-
suming your team honestly report all de-
fects – every time they find one, you can 
gather information to analyze at the 
macro level.  Do you do this to point fin-
gers at individuals who have (in one way 
or another) created the bugs?   
 

Absolutely NOT!! 
 

What you can do at the macro level 
though, is aggregate defect data to tell 
yourself things about your organization, 

your training, your processes and your 
resolve (as an organization) to improve. 
 

So, as you ask your team members to 
participate in testing, audits or peer re-
views, encourage them to thoroughly 
wring out the products they’ve been 
asked to review, test or audit.  And, en-
sure they have the time necessary to do 
just that.  Have them try hard to break the 
system, to find the last detail of discrep-
ancy, and to help the producer of the de-
liverable(s) understand what’s wrong, and 
how best to fix it. 
 

More importantly, you must help your 
project team understand they should not 
be embarrassed or alarmed someone 
found defects in the product(s) they’ve 
produced.  That’s what you’re asking their 
peers to do.  So, ensure they are working 
in an environment that does not threaten 
them when defects in their work are dis-
covered.  It is vitally important that they 
feel safe in their work place. 
 

And finally, you and your team need to 
fully document all defects so you can ac-
curately collect defect metrics.  That way, 
your senior leaders can better justify the 
training your team (as individuals and as 
an organization) need – and prepare for 
it.  It’s simply a better way of doing  
business…  �  

Perceptions about Defects 

“ ...you must help your 
project team 

understand they should 
not be embarrassed or 

alarmed someone 
found defects in the 
product(s) they’ve 

produced....”   

By Robin V. Horth, PMP 

Robin Horth, PMP, PPRC Vice 
President of Education and a Project 
Manager with EDS, is a contributing 
writer for the PPRC Communicator. 

� � January 8 – PPRC Monthly Meeting, 
Holiday Inn (Garden of the Gods & 
I25), 6:00 PM. 

� � January 31 - Project of the Year 
(POY) Candidate Projects Submitted 
to PPRC 

� � February 12 – PPRC Monthly Meet-
ing, Holiday Inn (Garden of the Gods & 
I25), 6:00 PM. 

� � February - Watch 
your email for the 
next workshop  
announcement! 

� � March 5 - PPRC 
Project of the Year  
Selected 

DATES TO REMEMBER 
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Owner/Client prior to nomination.  There can be no restrictions on the use of the submitted information after the final date of sub-
mission. 
 
General Criteria: 

� � Met or exceeded Owner/Client’s needs as evidenced by a letter from the Owner/Client. 

� � Met or improved on budget and schedule performance when compared with original established budget and schedule goals. 

� � Originality and uniqueness of applied project management techniques, including innovative application of practices/methods. 

� � Technical aspects and advancement of the image of the project management profession as demonstrated by effective appli-
cation of the principles set forth in A Guide to the Project Management Body of Knowledge (PMBOK® Guide). 

� � Complexity of the project and unusual conditions, issues, and barriers requiring special management team action and per-
formance. 
 

Nomination Procedure:  The PMI Project of the Year is selected through a three-tier process. 
 

Preliminary Level:  POY nominations must first be submitted to a participating PMI Chapter.  The Chapter’s POY Project Man-
ager must contact the PMI Marketing Department to identify himself or herself as the designated contact.  The Chapter POY Pro-
ject Manager will act as liaison with Headquarters and receive all pertinent communications and documents.  Submissions are due 
to the Chapter(s) no later than 30 January 2004.  Projects submitted at this level will be reviewed by a panel of judges designated 
by the Chapter(s), with the selection of projects that will advance to the next level completed by 5 March 2004.  Project nomina-
tions submitted from a location outside the jurisdiction of a participating PMI Chapter are due by postal mail at PMI Headquarters 
no later than 30 January 2004.  Such nominations will be reviewed by an “at large” panel, composed of reviewers who have dem-
onstrated successful project management expertise.  The “at large” panel will select a project that will advance to the next level by 
5 March 2004. 
 
Semi-Finalist Level:  Projects selected at the Preliminary Level of Competition must submit one original plus ten copies of the 
project nomination at the Semi-Finalist Level.  Semi-Finalist submissions are due by postal mail at PMI Headquarters no later than 
19 March 2004. 
 
Semi Finalist nominations will be reviewed by a panel of judges from around the world who have demonstrated successful project 
management expertise.  The three top project entries will be selected as Finalists by 14 May 2004. 
 
Finalist Level: The entrees of the three finalists will be sent no later than 4 June 2004 to a panel of reviewers from around the 
world who have demonstrated successful project management expertise. 

The recipient of the PMI Project of the Year Award will be selected  by 16 July 2004.  Formal announcement of the recipient will 
be made by the Chair of the PMI Board of Directors at a specified PMI event. 
 
Frequency and Number: 

� � Preliminary Level – Acknowledged by Chapters as part of the preliminary competition program. 

� � Semi-Finalist Level – Total of three. 

� � Finalist Level – Not more than one PMI Project of the Year Award will be selected annually. 

Presentation and Recognition: 

� � Preliminary Level – Acknowledged by Chapters as part of the Chapter  
program. 

� � Semi Finalist Level – Acknowledged by PMI Headquarters and sponsoring 
PMI Components. 

� � Finalist Level – Acknowledged by the PMI Board of Directors and PMI 
Headquarters.  Award to be formally presented at a specified PMI event.  
PM Network® article to follow the award presentation.  News release issued 
in conjunction with the submitting organization. 

The Official POY Submittal Guidelines and Format can be downloaded 
form the PMI Professional Awards Program section of the PMI Web site 
at www.pmi.org or obtained by contacting PMI Headquarters at +1-610-
356-4600 or e-mailing marketing@pmi.org.  � �

2004 PMI PROJECT OF THE YEAR AWARD�
(Continued from Page 1) 

Pamela S. Goodhue� Sep 12, 2003 

Patricia D. Orell Sep 17, 2003 

Peter D. Shearston Oct 31, 2003 

R. Thomas Burns Nov 05, 2003 

Colin Konrad  P.E. Nov24, 2003 

Lawrence H. Stahler Nov 24, 2003 

2003 PMPs 
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Newsletter design by: Alan Hergert 

www.coolwaterswebdesign.com 

� � PPRC has 355 members as 
of November 2003? 

� � PPRC has 127 PMPs? 

� � PPRC offers many programs 
including workshops, PMP 
Prep classes, outreach pro-
grams, monthly meetings, 
and more to Project Managers and their employers 
across the Front Range? 

� � Volunteers who log 20 hours of time can attend the 
PPRC PMP Prep class for free, and are also eligible to 
receive PDU credits from PMI? 

 

Did you know that PPRC needs your help? 

 

Contact any Board Member either by phone, email or at a 
PPRC meeting to discuss the volunteer opportunities in our 
Chapter.  Contact numbers are listed on our website:  
http://chapter.pmi.org/ppr/pprc-officers.html  

Did you know that... 


